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INTRODUCTORY NOTE 

 

An experiment in physical chemistry is designed with the aim to illustrate the basic principles 
in chemistry. Typically, every experiment will be accompanied by its background and 
underlying theory, detailed experimental procedure and suggestions on methods to analyze 
the results followed by a brief discussion. 
 
Before the laboratory session, please READ the General Laboratory Instruction 
(https://t.ly/72kRt) which provides the basic principles in physical methods. In the General 
Laboratory Instruction, you will first be introduced to the basic idea of measurements, 
standards and associated quantitative aspects such as units, dimensionalities, symbols, and 
uncertainty. This is followed by accuracy, precision, data analysis, error estimation, general 
equipment and tools, and scientific writing. It intends to give the necessary background 
discussion which you MUST read before entering the laboratory. It is also important that you 
continue to practice the advice given here not only during your study but throughout your 
lifetime as a scientist. Of course, the brief manual is by no means complete. You may refer to 
a more elaborate introduction on similar subject in most general chemistry textbooks. There 
are also many sources on the Internet which you can browse through. 
 
The physical chemistry experiments designed here are to accompany the physical chemistry 
lecture courses. Through these experiments you will experience measuring some of the 
physical properties of interest with known precision. Moreover, they will allow you to 
understand the concept behind the measurements and how to relate experimental results to 
the basic concepts in the lecture courses. 
 
The quantitative measurements you have made produces numerical values which are subject 
to error due to many reasons such as the nature of the instrument and how the experiment is 
designed. Thus, it is equally important to repeat the experimental procedure a few times until 
the result is consistent. Sometimes the experimental procedure may be varied to check for 
convergence of the values by different methods. In addition to these, a physical chemist must 
estimate the value of error in his measurement to get improved accuracy of the measured 
value compared to a standard value. 
 
A good laboratory practice is to process the raw data immediately to get a rough idea of the 
results of the experiment immediately. By doing so, anything which deviates from expectation 
may be checked immediately before dismantling the experimental set up. For example, graph 
should be plotted roughly during the laboratory. Should a linear behavior be expected and 
some points are found to deviate, then the experiments related to these odd data points may 
be repeated immediately.  
 
Laboratory report should be processed immediately for two obvious reasons. First, if the 
processed result is unsatisfactory, the experiment may be repeated immediately. Secondly, 
since the detail information about the experiment is fresh in memory a better report will be 
produced. 
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**This agreement is applicable for all PHYSICAL AND POLYMER CHEMISTRY Laboratory 

Classes** 

In the interest of safety and accident-prevention, there are regulations to be followed by all 

students in designated Chemistry Laboratories at the Department of Chemistry, Faculty of 

Science, Universiti Malaya (UM). Faculty and staff members are authorised to deny the use 

of any laboratory to students who do not adhere to the regulations mentioned below or in 

instances when the safety of any of the student, staff or faculty member in the laboratory might 

be jeopardised.  

Regulations for all Chemistry Laboratories are as follows: 

1. Common safety practice and guidelines MUST be obeyed at all times when you are in 

the laboratory. Please refer to the UM or Chemistry Department Safety Handbook 

regularly. This handbook is available in every laboratory. When unsure on any matter 

related to safety, seek help from the lecturer-in-charge.  

2. Proper attire must always be worn in all chemical laboratories, including shoes that 

completely cover the foot (no high-heeled shoes), and a shirt that covers the entire 

upper torso, including the stomach and the back. Lab coats must be worn in the 

laboratory at all times. Long hair must be tied back. No loose or baggy clothes and 

dangling jewellery is allowed. 

3. Safety eyewear must always be worn during laboratory sessions. 

4. CONTACT LENSES should not be worn in the lab as chemicals can get between the 

eye and the lens 

5. Prior to handling any chemical, please make sure you have read its Safety Data Sheet 

(SDS). 

6. Do not dispose mercury into the sink. Mercury is expensive, toxic and poisonous. Used 

and contaminated mercury must be transferred into the residue bottle which is 

provided. Any spillage of mercury MUST be reported to the lab assistant.  

7. DO NOT dispose of organic solvent into the sink. Any used organic solvent must be 

transferred into the appropriately labelled waste bottles. Please consult the lab 

assistant if you are uncertain.  

8. When dealing with compressed gases, high pressure or high voltage equipment, 

please read and understand the instruction thoroughly before proceeding with the 

experiment.  

9. Be organised. Maintain a clean, open work area free of anything except materials 

directly required for the exercise. Keep laboratory material/equipment away from 

edges of work surfaces and electrical cords from hanging below the surface of tables. 

10. Equipment and/or chemicals should never be taken out of the lab unless authorised 

by the instructor or laboratory staff. 

11. Be familiar with the location and the use of the following in your laboratory: e.g. broken 

glass receptacle, first-aid kit, emergency gas shut-off valves, closest fire alarm, fire 

extinguisher, eye wash, safety shower, and emergency exit and routes. 

12. Be prepared. Study the assigned experiment before you come to lab. Be familiar with 

the lab exercise to prevent confusion and accidents. No unauthorised experiments are 

to be performed. Students must follow the procedural instructions in the lab 

handout/manual unless modifications to the procedures have been announced by the 

CHEMICAL LABORATORY  
SAFETY AGREEMENT 
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laboratory supervisor, in which case the student must follow the supervisor’s 

procedural instructions. 

13. NEVER TOUCH ANY FORM OF BROKEN GLASS. Broken glass should be disposed 

of only by laboratory staff. 

14. Lab experiments have been designed to minimize unnecessary exposure to any 

hazardous substances; however, it is not advisable for pregnant women or those with 

certain medical conditions to be exposed to any chemicals. We cannot ensure that a 

pregnant student will not be exposed to chemicals that might be unhealthy for her or 

her foetus. In addition, we cannot know the level of exposure, the length of exposure 

or the number of encounters that might occur with any chemical during a semester. By 

maintaining the safety rules, we expect that all students, including a pregnant student, 

should be able to carry out lab procedures safely. However, it is the Department’s 

professional advice that pregnant students should be advised NOT to take a lab course 

unless she is willing to understand and assume the risks. She should certainly be 

seeking and following proper medical advice from her physician. 

15. If you are pregnant, or you suspect, should become, or plan to become pregnant during 

the semester, or have any medical condition or concern, including but not limited to the 

following, immunocompromised system, seizures, epilepsy, severe allergies, it is your, 

the student’s, responsibility to consult with your medical care provider regarding any 

medical issue associated with taking this lab. Students are encouraged to provide their 

physician with a list of the chemicals that they might be exposed to while in lab. They 

should also check the SDS sheets to be aware of the hazards of the chemicals. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



v 
 

  

**This copy is to be signed and kept by student** 

I acknowledge receipt and that I have read and understand the lab safety regulations stated 

in the Chemical Laboratory Safety Agreement and in UM or Chemistry Department Safety 

Handbook, and that I received a briefing on these regulations from my laboratory 

Instructor/Lecturer. I also acknowledge that I was given the opportunity to ask any relevant 

questions during the safety briefing. I understand that there may be inherent risks and possible 

hazardous exposure with laboratory experiments depending on one’s medical condition. If I 

am pregnant, or suspect to be pregnant, should become, or plan to become pregnant during 

the semester, or have a medical condition that may be affected by my participation in this 

laboratory session, I understand that it is my responsibility to discuss any and all issues with 

my medical care provider.  

Further, I accept any and all risk associated with the use of the Chemistry laboratory(s) and 

the equipment contained therein. I also understand that I am responsible for my personal 

property at all times. By signing this agreement, I fully understand and consider it my 

responsibility to comply with the safety regulations outlined above. I hereby agree for myself, 

my family, successors, and assigns to hold harmless the Universiti Malaya, Department of 

Chemistry of the Universiti Malaya, Faculty of Science of the Universiti Malaya, Lecturers, 

Laboratory Staff and assigns from any and all claims, causes of action, suits, liabilities, 

damages, losses, demands, costs, expenses or judgments for damages or injuries to myself 

or others arising from my participation in the lab, whether or not I consulted a medical provider 

as delineated above. 

Name : Course : 

Matric Number : Sem / 
Session 

: 

IC Number : Lecturer : 

    
    
Signature : Date : 
    

 

Provide the name and telephone number of two “Emergency Contacts” that can be reached 

during lab class times. Please note that your medical or physical condition may be released 

to the contact person at the time of the emergency call. Indicate the relationship to the person 

and the telephone location (office, home or cellular). 

Emergency contact 1   
Name: Relationship: Contact number: 
   
Emergency contact 2   
Name: Relationship: Contact number: 

SAFETY INFORMATION 
ACKNOWLEDGEMENT 

INFORMED CONSENT 
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**This copy is to be signed by student and returned to lecturer/PPS** 

I acknowledge receipt and that I have read and understand the lab safety regulations stated 

in the Chemical Laboratory Safety Agreement and in UM or Chemistry Department Safety 

Handbook, and that I received a briefing on these regulations from my laboratory 

Instructor/Lecturer. I also acknowledge that I was given the opportunity to ask any relevant 

questions during the safety briefing. I understand that there may be inherent risks and possible 

hazardous exposure with laboratory experiments depending on one’s medical condition. If I 

am pregnant, or suspect to be pregnant, should become, or plan to become pregnant during 

the semester, or have a medical condition that may be affected by my participation in this 

laboratory session, I understand that it is my responsibility to discuss any and all issues with 

my medical care provider.  

Further, I accept any and all risk associated with the use of the Chemistry laboratory(s) and 

the equipment contained therein. I also understand that I am responsible for my personal 

property at all times. By signing this agreement, I fully understand and consider it my 

responsibility to comply with the safety regulations outlined above. I hereby agree for myself, 

my family, successors, and assigns to hold harmless the Universiti Malaya, Department of 

Chemistry of the Universiti Malaya, Faculty of Science of the Universiti Malaya, Lecturers, 

Laboratory Staff and assigns from any and all claims, causes of action, suits, liabilities, 

damages, losses, demands, costs, expenses or judgments for damages or injuries to myself 

or others arising from my participation in the lab, whether or not I consulted a medical provider 

as delineated above. 

 

Name : Course : 

Matric Number : Sem / 
Session 

: 

IC Number : Lecturer : 

    
    
Signature : Date : 

 

Provide the name and telephone number of two “Emergency Contacts” that can be reached 

during lab class times. Please note that your medical or physical condition may be released 

to the contact person at the time of the emergency call. Indicate the relationship to the person 

and the telephone location (office, home or cellular). 

Emergency contact 1   
Name: Relationship: Contact number: 
   
Emergency contact 2   
Name: Relationship: Contact number: 

 

SAFETY INFORMATION 
ACKNOWLEDGEMENT 

INFORMED CONSENT 
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SCIENTIFIC WRITING 

 

Log Book 

A scientist keeps all information on his/her experiment neatly and orderly. Thus, as part of 

your training to become a good scientist, you MUST have a log book or sometimes it is called 

a jotter book. Everything you do and measure in the day must be reported in the jotter book. 

DO NOT use loose papers to record your results. You may lose them. Moreover this log book 

or jotter book must be numbered and dated accordingly. It is also useful to have a carbonized 

jotter book which allows you to hand a carbonized copy of the result to the lab supervisor 

which in this case, the lecturer-in-charge. The log book should be readable to you after many 

years and certainly readable to other people. 

 

Formal Report 

Apart from keeping the laboratory log book, you are required to write a short formal report on 
every experiment assigned to you. Some lecturers may wish to assign you to write an 
extended report for one of these experiments. You can also use an Electronic Lab Notebook 
(ELN). Please discuss with your lecture-in-charge for the detailed format. 
 
Two types of report styles which we recommend are: a short scientific report and an  
extended scientific report. 
 

1) A Short Formal Report will have the following format:  
i.  Title Page  
ii.  Results and Discussion (separate section is highly recommended)  
iii.  Conclusion  
iv.  References 
 

2) An Extended Formal Report will have the following format  
i.  Title Page  
ii.  Background and Theory 
iii.  Procedure  
iv.  Results and Discussion (separate section is highly recommended)  
v.  Conclusion  
vi.  Future Work (optional) 
vii.  Appendices (optional) 
viii.  References 
 

Title Page 
It contains the title of the experiment, when the experiment was conducted (date), your 
name and your partner’s name (if any), your group and lecturer’s name.  
 
Background and Theory  
In the short formal report, it is unimportant to write the “Background and Theory” unless 
you are using a different theory than that suggested in the experimental manual. You may 
simply refer to the manual or obtain from references.  
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Procedure  
Likewise, in the short formal report, it is unimportant to write the “Procedure” since this is 
already clearly stated in the manual. If however, a different procedure is adopted for some 
reason (and this may happen), you must report this clearly.  
 
Results and Discussion  
All raw and processed results must be recorded neatly and clearly. Repeated values may 
be tabulated with clear headers. If there is more than one table, please give a clear and 
legible title to each one of them.  
 
Discussion section aims to analyze the results you obtain. This is done by describing 
them, explaining the results with respect to the theoretical expectation either by proving 
the theory or otherwise. When results are in agreement with the theory, (you may feel 
happy) the discussion may be written in support of the theory which may now be used to 
predict other possible conditions. However, if result differ from the expected, the 
discussion may be more interesting. Here is the case when the theory may be weak or 
wrong or the experimental result is wrong. Discussion may be centered in scrutiny of the 
theory and all its assumptions or on the other hand, on possible sources of errors in the 
experimental procedure.  
 
Conclusion  
This summarizes the experimental findings and relates them to the objectives of the 
experiment.  
  
References  
These days, no scientist works in isolation. Thus, as a good scientific practice, the 
reference section must be included to make students aware that the experiment they 
conducted is related to many other previous works which have been reported in the 
literature. 
 

 

 
 

 

 

 

 

 

 

 

Plagiarism Warning! 

Some of these experiments are carried out in groups of usually a pair of students. 

Therefore expectedly, each member of a group followed an identical procedure in the 

laboratory and has the same set of raw data. Members of a group are allowed to discuss 

the analysis of data with one another. However, preparation of the report including data 

analysis, interpretation and discussion must be prepared by the individual student 

submitting the report. 

The Department does not tolerate plagiarized reports! 
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GUIDELINES AND MARKING SCHEME FOR PRACTICAL REPORT 
 

Section A: Attendance (Total 5%)  

 

1. Attendance (5%) 

Score Criteria 

0 Student did not attend without any valid reasons.  

5 Student is present. 

 

Notes: 

 

1. The student MUST attend the laboratory session to be eligible for obtaining marks. 

NO marks will be given at all if the student did not attend any laboratory sessions 

without valid reasons. 

 

2. If the student did not attend any of the laboratory session, there MUST be an official 

explanation (i.e., Sick: MC from doctor; representing UM in activities: Official Letter 

from the Department/Faculty/University, etc.; Family reasons: Death of family member, 

etc.). 

 

Section B: Lab Performance − Skills and Technique (Total 20%)  

 

Score Criteria 

0-5 No skill is demonstrated; requires constant reminder about experimental 

procedures (can lead to poor experimental results); haphazard work area. 

6-10 Candidate lacked procedural knowledge (e.g. selection of inappropriate 

glassware/equipment/software, improper handling of glassware or chemicals); 

requires some reminder about experimental procedures; messy work area. 

11-15 Candidate showed appropriate procedural knowledge (e.g. correct selection of 

glassware, equipment or software) but made a few mistakes (e.g. wrong 

meniscus reading); work area cleanliness and safety could still be improved. 

16-20 Candidate showed appropriate procedural knowledge with minimal mistakes 

(high probability to obtain excellent experimental results); work area neat, tidy 

and safe 

 

Section C: Lab Jotter/Notebook (Total 25%)  

 

1. Pre-entering lab (5%) 

Score Criteria 

0 No preparation of experimental procedure. 

1-3 Summary of procedures too brief, lack of details and confusing. 

4-5 Presents easy to follow steps in lab experimental, logical and adequately 

detailed. 

 

2.  Laboratory Notebook/Jotter (20%) 

Score Criteria 

0 No jotter. 
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1-5 Little effort to record observations/information/data. 

6-10 Poor ability to record findings parallel to the lab action/observation; some 

important features are unavailable. 

11-15 Able to record findings parallel to the lab action/observation but could still be 

improved; all important features are available, but some observations, 

information and raw data are incomplete. 

16-20 Candidate is competent to record findings parallel to the lab action/observation; 

all important features are available (Date of experiment, complete information, 

observations and raw data). 

 

Section D: Lab Report (Total 40%) 

 

(I) Short Report 

 

Section Score Criteria 

Title  

(5 marks) 

0 No title. 

1 Too brief (e.g. “Lab Report”, “Mercury in Fish”, “Synthesis of 

Cinnamic Acid” or “Boiling Point of Water”). 

2-3 Too long or does not identify the complete subject of study 

(e.g. “Determination of iron”, “Determination of lead”, etc.). 

4-5 Identify the complete subject of study and encapsulates the 

purpose of the report/study (e.g. “Kinetics of the hydrolysis of 

t-butyl chloride at 30 oC”, “Synthesis of triphenylcarbinol via 

Grignard reaction” or “Determination of iron in red meat via 

spectrophotometry”). 

Objectives 

(5 marks) 

0 Section missing completely. 

1-3 Too vague, ambitious or broad in scope; contradict with 

methods; does not identify subject of study. 

4-5 Concise and brief; be interrelated and describes how to 

achieve that objective; clearly identify the subject of study; 

related to the experiment that has been done. 

Results  

(Data, figures, 

graphs, tables, 

observations, % 

yield, etc.) 

(30 marks) 

 

0 Section missing completely. 

1-7 No flow of results. Figures, graphs, tables contain errors or 

are poorly constructed, have missing titles, captions or 

numbers, units missing or incorrect, numerical data did not 

have correct significant figures, no error analysis, etc. 

8-15 Most figures, graphs, tables OK, some still missing some 

important or required features. 

16-23 All figures, graphs, tables are correctly drawn, but some have 

minor problems (e.g. incorrect significant figures, incomplete 

observation) or could still be improved. 

24-30 All figures, graphs, tables are correctly drawn, are numbered 

and contain titles/captions. Observations clearly stated. 

Numerical data contains correct significant figures and units. 

Discussion  0 Section missing completely. 
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(30 marks) 1-7 Lack of attempt to relate experimental findings and data with 

contemporary theories. Very incomplete or incorrect 

interpretation of trends and comparison of data indicating a 

lack of understanding of results. 

8-15 Some attempt to relate experimental findings and data but 

using inaccurate theories. Some of the results have been 

correctly interpreted and discussed; partial but incomplete 

understanding of results is still evident. 

16-23 Almost all of the results have been correctly interpreted and 

discussed, only minor improvements are needed. 

24-30 All of the important trends and data comparisons have been 

interpreted correctly and discussed; good relationship 

between experimental data and theory; good understanding 

of results is conveyed. 

Safety 

Precautions  

(5 marks) 

0 Section missing completely. 

1 Sentences are incomplete, focusing on minor points or lack 

important steps. 

2-3 State only 1-2 major and most important safety precautions. 

4-5 State at least 3 major and most important safety precautions. 

Conclusions 

(10 marks) 

0 Section missing completely. 

1-3 Conclusion missing the important points or is not supported 

by the experimental results. 

4-6 Conclusions regarding major points are drawn, but many are 

misstated, indicating a lack of understanding. 

7-8 All important conclusions have been drawn, could be better 

stated. 

9-10 All important conclusions have been clearly made, student 

shows good understanding. 

References  

(5 marks) 

0 Section missing completely. 

1-3 Incomplete references to the books or any other sources 

used in report. 

4-5 Correct in-text citations and the references in the reference 

list conform to all respects of the formatting convention (e.g. 

APA format). Complete references to the books or any other 

sources used in report. References in text are matched with 

references in reference list (e.g. no missing references). 

Appearance 

and Formatting 

(10 marks) 

1-3 Sections out of order, too much handwritten copy, sloppy 

formatting. 

4-6 Sections in order, contains the minimum allowable amount of 

handwritten copy, formatting is rough but readable. 

7-8 All sections in order, formatting generally good but could still 

be improved. 

9-10 All sections in order, well-formatted, very readable. 

 

Total section D marks = (x/100) × 40% 

 

** Late Report Submission: −1 mark / day 
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(II) Full Report 

 

Section Score Criteria 

Title  

(5 marks) 

0 No title. 

1 Too brief (e.g. “Lab Report”, “Mercury in Fish”, “Synthesis of 

Cinnamic Acid” or “Boiling Point of Water”). 

2-3 Too long or does not identify the complete subject of study 

(e.g. “Determination of iron”, “Determination of lead”, etc.). 

4-5 Identify the complete subject of study and encapsulates the 

purpose of the report/study (e.g. “Kinetics of the hydrolysis of 

t-butyl chloride at 30 oC”, “Synthesis of triphenylcarbinol via 

Grignard reaction” or “Determination of iron in red meat via 

spectrophotometry”). 

Introduction  

(10 marks) 

0 Section missing completely. 

1-3 Very little background information provided, or information is 

incorrect. 

4-5 Some introductory information, but still missing some major 

points. 

6-8 Introduction is nearly complete, missing some minor points. 

9-10 Introduction complete and well-written; provides all 

necessary background principles for the experiment with 

evidence of extra reading. 

Objectives 

(5 marks) 

0 Section missing completely. 

1-3 Too vague, ambitious or broad in scope; contradict with 

methods; does not identify subject of study. 

4-5 Concise and brief; be interrelated and describes how to 

achieve that objective; clearly identify the subject of study; 

related to the experiment that has been done. 

Experimental 

Procedure  

(10 marks) 

0 Section missing completely. 

1-3 No sub-sections, missing several important experimental 

details or not written in paragraph format. Parts have been 

included under the wrong sub-section. 

4-5 Written in paragraph format, still missing some important 

experimental details. 

6-8 Written in paragraph format, important experimental details 

are covered, some minor details missing. 

9-10 Well-written in paragraph format, all experimental details are 

covered. 

Results  

(Data, figures, 

graphs, tables, 

observations, % 

yield, etc.) 

(20 marks) 

 

0 Section missing completely. 

1-5 No flow of results. Figures, graphs, tables contain errors or 

are poorly constructed, have missing titles, captions or 

numbers, units missing or incorrect, numerical data did not 

have correct significant figures, no error analysis, etc. 

6-10 Most figures, graphs, tables OK, some still missing some 

important or required features. 
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11-15 All figures, graphs, tables are correctly drawn, but some have 

minor problems (e.g. incorrect significant figures, incomplete 

observation) or could still be improved. 

16-20 All figures, graphs, tables are correctly drawn, are numbered 

and contain titles/captions. Observations clearly stated. 

Numerical data contains correct significant figures and units. 

Discussion  

(20 marks) 

0 Section missing completely. 

1-5 Lack of attempt to relate experimental findings and data with 

contemporary theories. Very incomplete or incorrect 

interpretation of trends and comparison of data indicating a 

lack of understanding of results. 

6-10 Some attempt to relate experimental findings and data but 

using inaccurate theories. Some of the results have been 

correctly interpreted and discussed; partial but incomplete 

understanding of results is still evident. 

11-15 Almost all of the results have been correctly interpreted and 

discussed, only minor improvements are needed. 

16-20 All of the important trends and data comparisons have been 

interpreted correctly and discussed; good understanding of 

results is conveyed. 

Safety 

Precautions  

(5 marks) 

0 Section missing completely. 

1 Sentences are incomplete, focusing on minor points or lack 

important steps. 

2-3 State only 1-2 major and most important safety precautions. 

4-5 State at least 3 major and most important safety precautions. 

Conclusions 

(10 marks) 

0 Section missing completely. 

1-3 Conclusion missing the important points or is not supported 

by the experimental results. 

4-6 Conclusions regarding major points are drawn, but many are 

misstated, indicating a lack of understanding. 

7-8 All important conclusions have been drawn, could be better 

stated. 

9-10 All important conclusions have been clearly made, student 

shows good understanding. 

References  

(5 marks) 

0 Section missing completely. 

1-3 Incomplete references to the books or any other sources 

used in report. 

4-5 Correct in-text citations and the references in the reference 

list conform to all respects of the formatting convention (e.g. 

APA format). Complete references to the books or any other 

sources used in report. References in text are matched with 

references in reference list (e.g. no missing references). 

Appearance 

and Formatting 

(10 marks) 

1-3 Sections out of order, too much handwritten copy, sloppy 

formatting. 

4-6 Sections in order, contains the minimum allowable amount of 

handwritten copy, formatting is rough but readable. 
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7-8 All sections in order, formatting generally good but could still 

be improved. 

9-10 All sections in order, well-formatted, very readable. 

 

Total section D marks = (x/100) × 40% 

 

** Late Report Submission: −1 mark / day 

 

Section E: Assessment of Understanding/Revision on Conducted Experiments (10%)  

 

Score Criteria 

x Test/Quiz/Lab Presentation, etc. 

 

* For Section E: Assessment - it is up to the lecturer-in-charge to decide whether he/she wants 

to carry out the method of assessment (simple test, presentation, etc). 
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EXPERIMENT 1 

 

BOMB CALORIMETER 

 

Objectives:  

 

1. Calibration of the bomb calorimeter with benzoic acid to obtain the heat capacity of the 

calorimeter, Ccal.  

2. To determine the heat of combustion, ΔHc, for anthracene. 

3. To calculate the standard formation enthalpy of anthracene, ΔHf.  

 

1 Theory 

Enthalpies of combustion can be measured by burning a known amount of material in a bomb 

calorimeter and determining the temperature change. The bomb is pressurised with oxygen 

to ensure complete combustion. Then the bomb is immersed in bucket filled with fixed amount 

of water. Heat loss to the surroundings can be prevented by use of a jacket around the 

calorimeter; the reaction is then adiabatic. The jacket lid is fitted with a calorimeter 

thermometer and stirrer both of which extend into the water. The sample is ignited by passing 

a current through a fuse wire within the bomb. As the experiment is to determine the 

temperature increase of a system under adiabatic conditions, the change of temperature can 

be adjusted to that of the water surrounding the bomb. Figure 1 shows the bomb calorimeter. 

 

 

 

(a)                                                                (b) 

 

Figure 1. (a) Assembled bomb calorimeter, (b) Parr oxygen bomb. 

 

Determination of heat capacity of the calorimeter system is made by igniting a known quantity 

of a substance of known heat of combustion as a standard. Heat capacity is the amount of 
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calories necessary to raise the temperature of the entire calorimeter system by one degree 

Celsius. Benzoic acid of high purity is usually employed. Bomb calorimetry was once widely 

used in chemistry, since it provides thermodynamic data in a very direct way; it is still used in 

the fuel and food industries.  

 

In the determination of the heat of combustion with the bomb calorimeter, it must be 

remembered that the measurement is made at constant volume and not at constant pressure. 

Therefore, the heat of combustion calculated is ∆U rather than ∆H. In order to convert to ∆H, 

the heat of combustion at constant pressure, the following expression is used: 

 

∆𝐻 = ∆𝑈 + ∆𝑛𝑅𝑇 

 

in which ∆n is the difference between the number of moles of gaseous products formed at 25 

°C (at which temperature the standard state of water is the liquid) and the number of moles of 

gaseous reactants. For the combustion of benzoic acid the chemical equation is 

 

𝐶6𝐻5𝐶𝑂𝑂𝐻 (𝑠) +  7.5O2 (𝑔) → 7𝐶𝑂2(𝑔) + 3𝐻2𝑂 (𝑙) 

 

and ∆n is equal to -0.5. Hence for the combustion of one mole of benzoic acid at 25 °C  

 

∆𝐻 = ∆𝑈 − (0.5 × 8.31 × 298𝐽) = ∆𝑈 − 2480𝐽 
 

2 Materials 

 

Apparatus: Parr calorimeter system, fuse wire, oxygen cylinder, conical flask, burette, 

pipette, thermometer, stopwatch. 

 

Chemicals: benzoic acid, anthracene. 

 

 

3 Experimental Procedure 

 

3.1 Calibration of the bomb calorimeter with benzoic acid 

 

Use a pellet of benzoic acid weighing between 0.9 to 1.1 g. Determine the corrected 

temperature rise, also titrate the bomb washings to determine the nitric acid correction and 

measure the length of unburned fuse wire. 

 

3.2 Heat of combustion for anthracene 

 

Procedure for the anthracene test is exactly the same as for testing of benzoic acid. Use a 

pellet of anthracene weighing between 0.9 to 1.1 g. Determine the corrected temperature rise, 

also titrate the bomb washings to determine the nitric acid correction and measure the length 

of unburned fuse wire.  

 

Pellet Formation 
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Care must be taken to avoid overcharging the bomb. It must be realized that the peak pressure 

developed during combustion is proportional to the size of the sample and to the initial oxygen 

pressure. Pellet size should be limited to not more than 1.1 grams. Weigh out approximately 

1.0 g of sample. Use the pellet press to make a pellet. Weigh the pellet and carefully place it 

in the stainless steel combustion cup. 

 

Ignition Wire 

Measure out approximately 10 cm of fuse wire. It will be necessary to measure the length of 

unburned wire after combustion since this is an important factor in the calculations. Set the 

bomb head in the support stand and attach the length of fuse wire as illustrated in Figure 2. 

Insert the wire through each eyelet then slide each cap downward to complete the connection. 

Place the sample cup (with sample sitting in the centre of the cup) in the cup holder and bend 

the wire in a ‘v’ shape. The wire must be bent down as far as possible so that it touches the 

surface of the pellet and stays there. 

 
Figure 2. The proper threading of the electrodes and sample placement. 

 

Liquids in the Bomb 

Pipette 1.0 ml of distilled water into the bomb to absorb the oxides of nitrogen formed from 

nitrogen present in the oxygen mixture. 

 

Closing the Bomb 

Care must be taken not to disturb the sample when sealing and charging the bomb. Slide the 

head assembly into the bomb cylinder, screw open the vent cap on the head assembly to allow 

air to be expelled, and push the head down as far into the cylinder as it will go. Close the vent 

cap tightly. A tight seal is needed to prevent pressurised oxygen from leaking. 

 

Installing the Oxygen Connection 

Mount the bomb in the bench clamp. Slip on the oxygen tank connection hose to the pin on 

the head assembly.  

 

Filling the Bomb with oxygen 

Open the oxygen tank valve. Open the regulator valve SLOWLY for gradual flow of oxygen. 

Watch the gauge as the bomb pressure rises to the desired filling pressure (25-30 atm.). Once 

the desired pressure is reached, close the control valve followed by the tank valve. If oxygen 

is introduced too rapidly, the sample could be blown away from its initial position inside the 
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bomb. Use the quick-release valve to QUICKLY remove oxygen tank connection to minimise 

oxygen escape. Slight leakage is normal but continual leakage is a problem. 

 

Precautions: 

1. If there is a continual escape of gas from the bomb head connections once the oxygen 

tank valve is unscrewed the bomb is defective and should not be used. 

2. If the bomb does not hold pressure and you can hear oxygen escaping around the vent 

cap, then the cap is not sealed tightly enough. Tighten the screw cap by hand again 

and try to pressurise the bomb. 

3. Should you accidentally introduced too much of oxygen into the bomb, do not proceed 

with the combustion. Unscrew the oxygen tank connection and exhaust the bomb in 

the hood. This can be done by opening the vent cap. Reweigh the sample before 

repeating the filling procedure. 

 

Operating the Calorimeter 

Place the chromium plated elliptical bucket into the fiberglass jacket such that the three 

indentations in the bucket register with the locating feet in the jacket. Fit the wire bomb lifter 

into the holes in the knurled bomb screw cap, loosen the bench clamp, then raise the bomb 

by a finger inserted through the hole in the lifter. Do not hold the outside of the lifter, this would 

cause it to open thus releasing the bomb. Place the bomb onto the indentation in the bottom 

of the bucket then remove the lifter. Connect the ignition wire to the terminal socket on the 

bomb head.  

 

Fill to the mark a 2000 mL volumetric flask with water. Transfer this quantitatively to the bucket. 

Lift the jacket lid from the large stand onto the jacket. Turn the stirrer by hand to be sure that 

it runs freely, then slip the drive belt onto the pulley. Start the stirrer and wait 5 or 10 minutes 

to allow the apparatus to thermally stabilise, then start a timer and take temperature readings 

every 20 seconds. Although the thermometer is calibrated in 0.02 °C divisions, you should be 

able to estimate temperatures to about ± 0.003 °C with the help of the thermometer magnifier. 

Record the temperature until it has changed at a uniform rate (probably about 0.01 – 0.02 °C 

in every 100 seconds) for 5 or 6 readings. 

 

The Parr instruction manual gives the following warning: 

"CAUTION: DO NOT HAVE THE HEAD, HANDS OR 

ANY PART OF THE BODY DIRECTLY OVER THE 

BOMB DURING THE FIRING PERIOD, AND DO NOT 

GO NEAR THE BOMB FOR AT LEAST 20 SECONDS AFTER FIRING." 

 

Plug in the power supply then, noting the time, stand back and push the firing button for 5 

seconds. The red light should normally flash on for about ¼ second. At approximately 20 

seconds after ignition the temperature will begin to rise. The rate of rise will be large at first 

and then decrease as the bomb, water and bucket approach a new equilibrium temperature. 

The nature of temperature rise is indicated by the typical temperature rise curve shown in 

Figure 3. It is not necessary to plot a similar curve for each test, but accurate time and 

temperature observations must be recorded to identify the critical points needed to calculate 

the caloric value of the sample or the energy equivalent for the calorimeter. 
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The time required to reach the 60 % point can be found by linear interpolation from readings 

taken during the rise period. This requires temperature observations at 45, 60, 75, 90, and 

105 seconds after firing.  

 

After rapid rise period (about 4 or 5 minutes after ignition), record temperature at one-minute 

intervals until the differences between successive readings has been constant for five minutes. 

After the last temperature observation has been made, stop the motor, remove the belt and 

lift the cover and the stirrer from the calorimeter. Lift the bomb out of the bucket; remove the 

remove the ignition leads and wipe the bomb with a clean towel. Use the lifter to put the bomb 

into the bench clamp. Carefully unscrew the release valve to release the residual gas pressure 

before attempting to remove the cap. After all pressure has been released, unscrew the cap, 

lift the head out of the cylinder and place it on the support stand. Check the interior of the 

bomb for soot or other evidence of incomplete combustion. If such evidence is found, the test 

will have to be discarded. Wash all the interior surfaces of the bomb with a jet of distilled water 

and collect the washings in conical flask. Titrate the bomb washing with a standard sodium 

carbonate solution using methyl orange or methyl red indicator. A 0.0725 N sodium carbonate 

solution is recommended for this titration to simplify the calculation. Remove all unburned 

pieces of fuse wire from the bomb electrodes, straighten and measure the length of the 

remaining ends of the fuse wire.  

 

Dry the inside of the bomb then repeat the above procedure with the other sample.  

 

NITROGEN CORRECTION 

When the material is burnt, some the nitrogen in it (and the air) is oxidised and combined with 

water vapour to form HNO3. This reaction result in acid formation within the bomb, and require 

a correction to account for the heat liberated in the formation. You can rinse this acid out of 

the bomb and titrate with Na2CO3 to get the actual amount of HNO3 produced.  

 

Fuse Wire Correction 

The wire used as a fuse for igniting the sample is partly consumed in the combustion. Thus 

the fuse generates heat both by the resistance it offers to the electrical current and by the heat 

of combustion of that portion of the wire which is burned. It can be assumed that the heat input 

from the electric firing current will be the same when standardising the calorimeter as when 

testing an unknown sample, and this small amount of energy therefore can be neglected. 

However, the amount of wire consumed will vary from test to test and therefore a correction 

must be made to account for the heat of combustion of the metal. 

 

The amount of wire taking part in the combustion is determined by subtracting the length of 

the recovered unburned portion from the original length of 10 cm. The correction is then 

computed for the burned portion by assuming a heat of combustion of 2.3 calories per cm for 

Parr 45A10 (No. 34 B & S gage “Chrome C”) wire. 

 

4 Calculations 

For reach run, plot the corrected temperature vs. time. Determine an approximate temperature 

change and the time at which the temperature was at 60% of the net change. The following 

data should be collected for each run: 

 

𝑎 = time of firing 
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𝑏 = time (to nearest 0.1 min.) when the temperature reaches 60% of the total rise (maximum 

𝑇 - minimum 𝑇) = ∆𝑇; 0.6 × ∆𝑇 =  ∆𝑇 at 60%of total rise. The time at this temperature can be 

determined from the plot. 

T𝑎 = temperature at beginning of period (after initial temp. rise and before firing) in which the 

rate of temperature change became constant. 

T𝑐  = temperature at time 𝑐 

r1= rate (
𝑡𝑒𝑚𝑝

𝑚𝑖𝑛
) at which temperature was rising during the 5 minutes period before firing 

r2= rate (
𝑡𝑒𝑚𝑝

𝑚𝑖𝑛
) at which the temperature was rising during the 5 minutes period after time 𝑐. If 

the temperature was falling instead of rising after time 𝑐, r2 is negative and the quantity 

−r2(𝑐 − 𝑏) becomes positive and must be added when computing the corrected temperature 

rise. 

e1 = correction (in calories) for heat of formation of nitric acid (HNO3)  

e1 = millilitres (mL) of standard alkali solution used in the acid titration  

𝑒3 = correction (in calories) for the heat of combustion of fuse wires 

𝑒3 = centimetres (cm) of fuse wire consumed in firing × 2.3  

        (when using Parr 45C10 nickel chromium fuse wire) OR 

𝑒3 = centimetres (cm) of fuse wire consumed in firing × 2.7  

        (when using No. 34B. & S. gage iron fuse wire) 

 

The net corrected temperature rise 

 

Δ𝑇 = 𝑇𝑐 − 𝑇𝑎 − 𝑟1(𝑏 − 𝑎) − 𝑟2(𝑐 − 𝑏) 

 

 
Figure 3. Typical temperature rise curve 
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1. Calibration of the calorimeter with benzoic acid  

 

ENERGY EQUIVALENT FACTOR (W) OF THE CALORIMETER: 

 

The energy equivalent, W, of the calorimeter is the energy required to raise the temperature 

one degree Celsius, expressed as calories per degree Celsius. The data obtained from the 

trials with benzoic acid will be used for the determination. 

 

𝑊 =
𝐻𝑚 + 𝑒1 + 𝑒3

Δ𝑇
 

 

𝑊 = energy equivalent (heat capacity) of the calorimeter in 
𝑐𝑎𝑙𝑜𝑟𝑖𝑒𝑠

°𝐶
 

𝐻 = heat of combustion of the standard benzoic acid sample in calories per gram  

𝑚 = mass of the standard benzoic acid pellet in grams. 

Δ𝑇 = net corrected temperature rise in °𝐶 

e1 = correction for heat of formation of nitric acid in calories 

e3 = correction for heat of combustion of the firing wire in calories 

 

Example: 

Standardisation with a 1.1651 g benzoic acid sample (6318 cal/g) produces a net corrected 

temperature rise of 3.077 °C. The acid titration required 11.9 ml of standard alkali and 8 cm of 

fuse wire were consumed in the firing. Substituting in the standardisation equation: 

 

𝑊 =
(6318)(1.1651) + 11.9 + 18.4

3.077
= 2402.1 cal/∘ C 

where: 

𝐻 = 6318 cal/g 

𝑚 = 1.1651 g 

𝑒1 = (11.9 ml)(1 cal/ml) = 11.9 cal 

𝑒3 = (8 cm)(2.3 cal/cm) = 18.4 cal 

Δ𝑇 = 3.077 °C 

 

2. Gross heat of combustion for anthracene, 𝐻𝑔 

 

𝐻𝑔 =
Δ𝑇𝑊 − 𝑒1 − 𝑒3

𝑚
 

 

Molar Heat of Combustion of anthracene at Constant Pressure 𝚫𝑯: 

By definition, a change in enthalpy Δ𝐻 is related to the corresponding change in internal 

energy Δ𝑈 by the equation: 

 

Δ𝐻 = Δ𝑈 + Δ(𝑃𝑉) 

 

When heat is given off in the combustion, the convention is negative. Also assuming that the 

gaseous products obey the perfect gas law and that the Δ(𝑃𝑉) terms of solids and liquids are 

negligible: 
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Δ(𝑃𝑉) = Δ𝑛𝑔𝑎𝑠𝑅𝑇 

 

Where Δ𝑛𝑔𝑎𝑠 is the increase (or decrease) in the number of moles of gas during combustion. 

Thus we obtain our working definition: 

 

Δ𝐻 = Δ𝑈 + Δ𝑛(𝑅𝑇) 

 

Δ𝑈 = gross heat of combustion 

𝑅 = ideal gas constant  

𝑇 = temperature of the products if they were returned to the initial temperature of the 

experiment at the time of firing. 

 

 

5 Experiment 

 

(a) Determine the water equivalent of the bomb calorimeter with benzoic acid. 

(b) Determine the heats of combustion of anthracene. Repeat the experiment if necessary. 

Hence calculate the standard enthalpy of formation and compare with the literature 

values. 

 

6      Quantum Chemical Calculation for Standard Enthalpy of Combustion of 

Anthracene 

 

 Objective 

             

           To calculate the standard enthalpy of combustion of anthracene using quantum 

chemical methods and compare it with experimental values. 

           Computational Methodology 

1. Software and Computational Resources: 

o Use Gaussian software to calculate the electronic energy by approximating the 

Schrodinger Equation. 

 

2. Molecular Geometry Optimization: 

o Calculation Setup: 

 Use GaussView to prepare the molecular geometry draft of anthracene, 

O2, CO2 and H2O. 

 Submit each draft geometry separately to Gaussian in Window for 

calculation as shown below instruction 

1. Select Calculate 

2. Select Gaussian Calculation Setup 

3. Select Opt+Freq in Job Type 

4. Select DFT in Method section and choose B3LYP 
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5. Select 6-31G(d) in Basis Set  

 

6. Select Submit 

7. Save the input file in your directory and the calculation will begin. 

 

o Optimisation and Data Compilation: 

 Perform geometry optimization at B3LYP level using the 6-31G(d) basis 

set. 

 Geometry optimisation performed to relax the geometry at minima on 

potential energy surface. 

 Only minima structure can be used for calculating the enthalpy of 

reaction such as combustion. 

 Once computation done (Normal Termination in Gaussian Calculation), 

there are FOUR Gaussian calculation output log files. 

 Open each of the log file and extra the electronic energies as shown 

below. 

1. Select Results -> Summary 
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2. Copy and Paste the electronic energy into Excel 

 

3. Repeat for the other log files. 

 

3. Calculation of Standard Enthalpy of Combustion: 

o Use the following thermodynamic equation to calculate the standard enthalpy 

of combustion based on the electronic energies obtained. 

C14H10   +    O2     CO2   +   H2O 

EANT          EO2    ECO2        EH2O 

Chemical System Electronic Energies / Hartree 

EANT −539.53049 

EO2 −150.32004 

ECO2 −188.58094 

EH2O −76.408954 

o ΔHcombustion = (ECO2 × 14 + EH2O × 5) − (EANT + EO2 × 16.5) 
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o ΔHcombustion = (-188.58094 × 14 + -76.408954 × 5) − (-539.53049 + -150.32004 

× 16.5) 

                     = −2.36678 hartree × 2600 (conversion factor to kJ mol−1) 

                     = −6214 kJ mol−1 

 

4. Comparison with Experimental Values: 

o Compare the calculated standard enthalpy of combustion with the experimental 

value obtained from bomb calorimetry and literature review. 

     7              References 

 

1. Finlay, Practical Physical Chemistry, 8th Ed. 

2. “Mahler-Cook” Bomb Calorimeter manual 

3. Shoemaker and Garland, Experiments in Physical Chemistry, 2nd Edition, McGraw-Hill, 

1962. 
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EXPERIMENT 2 

 

DETERMINATION OF ACID DISSOCIATION CONSTANT FOR METHYL RED 

 

Objective: Determine the acid dissociation constant for methyl red (a type of dye) using 

visible spectrophotometry. 

 

1 Theory 

 

The constant K, for this equilibrium: 

 

 
 

Is given as 𝐾 =
[𝐻+][𝑀𝑅−]

[𝐻𝑀𝑅]
  

  

Methyl red is a type of dye: ο-(p-dimethylaminophenylazo)benzoic acid (C15H15N3O2, 

Molecular weight 269.31). 

 

Methyl red is a weak acid in which its colour in aqueous solution depends on the pH. The H+ 

(or H3O+) in solution determines the ratio of MR- to HMR as the following equation: 

 

[𝑀𝑅−]

[𝐻𝑀𝑅]
=

𝐾𝑎

[𝐻3𝑂+]
 

 

At pH ≤ 4.2 the solution is red and pH ≥ 6.2 the solution is yellow. The human eye is sensitive 

towards colour changes when the ratio of the two colours is between 0.1 and 10. For methyl 

red in solution: 

 
[𝑀𝑅−]

[𝐻𝑀𝑅]
= 0.1   red solution 

 
[𝑀𝑅−]

[𝐻𝑀𝑅]
= 10   yellow solution 

 

The ratios are equal to 10Ka and 0.1Ka respectively. If we write HMR and MR- respectively as 

A and B, so 
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𝐾 =
[𝐻+][𝐵]

[𝐴]
    (1) 

 

For any material which absorbs light, according to Beer-Lambert law, absorption 𝐴𝑜𝑏𝑠 is given 

as 

𝐴𝑜𝑏𝑠 = 𝜀𝐿𝑐  

 

where c is concentration, L is path length and ε is coefficient of absorption which depends on 

the type of material which absorbs and to the wavelength of absorption. 

 

For system which is being investigated in this experiment, at one particular wavelength, the 

absorbing coefficient Aobs is given as 

 

𝐴𝑜𝑏𝑠 = 𝜀𝐴[𝐴]𝐿 + 𝜀𝐵[𝐵]𝐿  (2) 

 

Equation (2) can be written as 

 

𝐴𝑜𝑏𝑠 = 𝜀𝑎([𝐴] + [𝐵])𝐿   (3) 

 

where 𝜀𝑎 is the effective absorption coefficient. 

 

From equation (2) and (3), we get, 

 

[𝐴]

[𝐵]
=

[𝜀𝐵 − 𝜀𝑎]

[𝜀𝑎 − 𝜀𝐴]
 

 

Insert this equation into (1) will obtain 

 

[H+]

𝐾
=

[𝜀𝐵 − 𝜀𝑎]

[𝜀𝑎 − 𝜀𝐴]
=

[(𝜀𝐵 − 𝜀𝐴) − (𝜀𝑎 − 𝜀𝐴)]

(𝜀𝑎 − 𝜀𝐴)
 

Or  
1

(𝜀𝑎−𝜀𝐴)
=

[H+]

𝐾
(

1

𝜀𝐵−𝜀𝐴
) + (

1

𝜀𝐵−𝜀𝐴
)   (4) 

 

If the initial concentration of methyl red (𝑐𝑖) is constant for all solutions, so [A] + [B] = 𝑐𝑖 and 

equation (3) can be written as 

 

𝐴𝑜𝑏𝑠 = 𝜀𝑎𝑐𝑖𝐿    (5) 

 

For solutions which has methyl red in acidic form, the absorption, 𝐴𝑜𝑏𝑠
𝐴  will be given as 

 

𝐴𝑜𝑏𝑠
𝐴 = 𝜀𝐴𝑐𝑖𝐿    (6) 

 

Combining equation (5) and (6) will produce 

 

1

(𝜀𝑎 − 𝜀𝐴)
=

𝑐𝑖𝐿

(A𝑜𝑏𝑠 − 𝐴𝑜𝑏𝑠
𝐴 )
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And by combining the above equation with equation (4) will have 

 
𝑐𝑖𝐿

𝐴𝑜𝑏𝑠−𝐴𝑜𝑏𝑠
𝐴 = (

[𝐻+]

𝐾
) [

1

(𝜀𝐵−𝜀𝐴)
] + [

1

(𝜀𝐵−𝜀𝐴)
]  (7) 

   

since 𝑐𝑖 and L for all solutions are constant, the plot of 
1

𝐴𝑜𝑏𝑠−𝐴𝑜𝑏𝑠
𝐴  versus [H+] will give a straight 

line where, 

 

𝐾 =
𝐼𝑛𝑡𝑒𝑟𝑐𝑒𝑝𝑡

𝑆𝑙𝑜𝑝𝑒
 

 

For methyl red which exists in basic solution, the absorption will be given as 

 

𝐴𝑜𝑏𝑠
𝐵 = 𝜀𝐵𝑐𝑖𝐿    (8) 

 

With the same procedures, we will obtain the following expression 

 
𝑐𝑖𝐿

𝐴𝑜𝑏𝑠−𝐴𝑜𝑏𝑠
𝐵 = (

𝐾

[𝐻+]
) [

1

(𝜀𝐴−𝜀𝐵)
] + [

1

(𝜀𝐴−𝜀𝐵)
]  (9) 

 

And the plot of 
1

𝐴𝑜𝑏𝑠−𝐴𝑜𝑏𝑠
𝐵  versus 

1

[𝐻+]
 will give a straight line where K can be determined by 

 

𝐾 =
𝑆𝑙𝑜𝑝𝑒

𝐼𝑛𝑡𝑒𝑟𝑐𝑒𝑝𝑡
 

 

 

2 Materials 

 

Apparatus: UV-Vis spectrophotometer, pH meter, cuvettes, volumetric flask, pipette, 

thermometer. 

 

Chemicals: methyl red standard solution, hydrochloric acid (concentration 0.1 mol dm-3), 

sodium acetate solution (concentration 0.04 mol dm3) and acetic acid (concentration 0.1 mol 

dm3). 

 

3 Experimental Procedure 

 

 

PART A 

100 mL methyl red standard solution is prepared by adding 40 mL stock solution to 30 mL 

alcohol and diluted with distilled water. 

 

Two solutions will have to be prepared in order to choose a suitable wavelength to measure 

the absorption of several methyl red solutions which will be needed. One solution consists of 

methyl red in acidic form (which will be named acidic solution), while another solution consists 

of the basic form (which will be named basic solution). The acidic solution can be prepared by 

adding 5 mL methyl red standard solution with 10 mL hydrochloric acid (with 0.1 mol dm-3 
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concentration) and diluting this mixture to 100 mL. The base solution requires the dilution of 5 

mL methyl red standard solution and 25 mL sodium acetate solution (concentration 0.04 mol 

dm3) to become 100 mL. 

 

Record the spectrum from 400 nm to 700 nm for both solutions. You will have to draw a rough 

plot while performing more measurements to obtain the wavelength region of maximum 

absorption. With those results, choose the two most suitable wavelengths based on the 

absorption maximum Aobs with the change of pH. 

 

 

PART B 

You will also have to prepare several methyl red solutions which contain 0.01 mol dm3 sodium 

acetate and acetic acid concentrations varying from 0.001 mol dm-3 to 0.05 mol dm-3. Make 

sure that the total methyl red used for each solution are the same as for those prepared for 

the acidic and basic solution. Determine the pH value and absorption Aobs for the two 

wavelengths which you have selected earlier for each solution. At least two readings must be 

taken for each determination. 

 

The pH meter must be calibrated with two standard buffer solutions for pH 4 and pH 7. 

 

4 Results and Calculation 

 

1. Plot the spectrum for acidic solution and basic solution. Determine the wavelengths λA 

and λB which give maximum absorption for the acidic solution and basic solution (See 

Appendix 1 for Gaussian Peak Fitting). Record Aobs
A and Aobs

B which are seen at λA 

and λB. 

2. For the methyl red solutions with various concentrations of acetic acid, record all pH 

and Aobs which are determined at λA and λB. 

3. For Aobs which was obtained at λA calculate 
1

𝐴𝑜𝑏𝑠−𝐴𝑜𝑏𝑠
𝐴  and [H+] for each solution. Record 

your readings. 

4. For Aobs which was obtained at λB record 
1

𝐴𝑜𝑏𝑠−𝐴𝑜𝑏𝑠
𝐵  and 

1

[𝐻+]
  in a table. 

5. Plot 
1

𝐴𝑜𝑏𝑠−𝐴𝑜𝑏𝑠
𝐴  versus [H+] and determine the slope and intercept by using the least 

square method. Determine the K value and its uncertainty. 

6. Repeat (5) but plot 
1

𝐴𝑜𝑏𝑠−𝐴𝑜𝑏𝑠
𝐴  versus 

1

[𝐻+]
 . 

 

5 Questions 

 

1. Derive equation (9) starting from equation (8). 

2. Compare K values obtained from (5) and (6). Which of these values are accurate. 

3. Discuss whether the experiment can be performed using wavelengths other than λA 

and λB. 

 

6 Reference 

 

R. Chang, Physical Chemistry, 2nd edition, Macmillan, 1981, Chapter 12. 
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APPENDIX 1: Fit Gaussian Peak on UV/Vis Spectrum of Methyl Red in Acidic and Basic 

Solutions 

 

Objective: To determine the wavelength of maximum absorbance for methyl red in acidic and 

basic solutions 

 

Statistical Software & Resource 

1. Download the JMP Software  

● Login to the staff or student portal 

● Navigate to Download Software > Main Software > SAS Academic Suite & 

SAS JMP 

● Select the version supported by your operating system 

● Click Download  

2. Download the JMP License File  

● Login to the staff or student portal 

● Navigate to Download Software > Main Software > SAS Academic Suite & 

SAS JMP 

● Select the license based on the version of your JMP 

● Right-click to download the linked SID file (*.txt) to your desired location 

3. Installation instruction: 

● Navigate to the /JMP/JMP/<version>/<OS> directory 

● Double‐click the JMP installer setup.exe file 

 

Fitting Gaussian Peak with JMP 

1. Launch JMP: 

● Open JMP after installation 

● Click Open License when prompted 

● Navigate to select the downloaded SID file (*.txt) and then click Open 

● Enter your name and department, if you wish, and then click OK 

● Navigate to a permanent location and click Save to save the license file  

● Click OK to finish the licence installation and launch JMP 

 

2. Import the Spectrum Data: 

● Select File > Open 

● Navigate to the data file (*.csv or *.xlsx) containing your spectrum data 
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● Click Open 

● Save the imported data by selecting File > Save as 

 

3. Fit Gaussian Peak: 

● Launch the Fit Curve platform 

o Select Analyze > Specialized Modeling > Fit Curve 

● Specify Column Roles 

o Assign Absorbance to the Y, Response role 

o Assign Wavelength to the X, Response role 

o Click OK 

● Specify the Peak Model 

o Click the Fit Curve red triangle and select Peak Model > Fit Gaussian 

Peak 

 

4. Examine Model Fit Report: 

● Prediction Model - the algebraic form of the prediction formula and the 

parameters are given by: 

𝑓(𝑥) = 𝑎 ∙ exp (−
1

2
∙ (

𝑥 − 𝑏

𝑐
)

2

)   

where  

o 𝑎 is the peak height 

o 𝑏 is the peak position 

o 𝑐 represents the peak width 

● Summary Fit - the fit statistics for the Gaussian peak model 

● Parameter Estimates - the estimates of values of the parameters 𝑎, 𝑏, and 𝑐, 

which define the shape of Gaussian curve 

 

Estimating the Key Characteristics of the Peak   

1. Compute the 95% Confidence interval for Lambda-max:  

The wavelength of maximum absorbance is given by: 

 

𝜆𝑚𝑎𝑥 = 𝑏 ± 𝑈𝑏  

 

where  

 

𝑈𝑏 is the uncertainty in 𝑏, calculated as: 

 

𝑏𝑢𝑝𝑝𝑒𝑟 95% − 𝑏𝑙𝑜𝑤𝑒𝑟 95%

2
 

 

2. Compute the Peak Bandwidth:  
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𝐹𝑊𝐻𝑀 = 2 ∙ √2 ln 2 ∙ 𝑐 ± 𝑈𝐹𝑊𝐻𝑀 

 

where 

 

𝑈𝐹𝑊𝐻𝑀 is the uncertainty in the FWHM, calculated as: 

 

2 ∙ √2 ln 2 ∙ (
𝑐𝑢𝑝𝑝𝑒𝑟 95% − 𝑐𝑙𝑜𝑤𝑒𝑟 95%

2
) 
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EXPERIMENT 3 

 

THE HYDROLYSIS OF TERT-BUTYL CHLORIDE, C4H9Cl 

 

Objectives:  

1. To determine the order of reaction and the rate constant, k, for the hydrolysis of t-butyl 

chloride (t-BuCl), C4H9Cl, at 30 ºC, 35 ºC and 40 ºC. 

2. To investigate the effect of concentration to the rate constant at constant temperature. 

3. To calculate the activation energy, Ea, for the hydrolysis of t-butyl chloride. 

 

1 Theory 

The rate of reaction for the hydrolysis of C4H9Cl can be monitored via the measurement of the 

electrical conductivity.  This hydrolysis can neither be catalysed by the hydrogen ion nor by 

the hydroxyl ion.  Instead, the rate determining step is the slow ionisation, given as 

+
slow

C4H9Cl C4H9
+

Cl-
     (1) 

followed by the rapid step which involves the reaction of C4H9 with water, 

+
rapid

 +C4H9
+ C4H9OHH2O H+

    (2) 

Hence, the overall reaction can be written as 

 + + +C4H9Cl H2O C4H9OH H+ Cl-
    (3)  

Here, the electrical conductivity of the solution increases as the reaction proceeds due to the 

formation of the strong electrolyte, HCl. 

2 Materials 

Apparatus: Water bath with temperature controller, conductivity meter, boiling tubes, pipette, 

conical flask with stopper, thermometer, stopwatch. 

Chemicals: Ethyl Alcohol, 80% (v/v), tert-butyl chloride. 

 

3 Experimental Procedure 

▪  Add 50 mL of aqueous alcohol (80% alcohol v/v) into a large boiling tube, cover the 

tube, and immerse it into a water bath whose temperature is kept constant at 30 °C. 

▪  While waiting for the temperature of the alcohol to equilibrate, prepare a tube with a 

conductivity probe.   

▪  When the thermal equilibrium of the alcohol is achieved, pipette 0.3 mL of tert-butyl 

chloride into the alcohol.  Stir the mixture to ensure homogeneity.   
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▪  Insert the conductivity probe into the mixture and start the stopwatch immediately.  

▪   The conductivity can be measured with a conductivity meter.  However, prior to using 

the conductivity meter, it has to be calibrated with the standard KCl (0.745 g/L solution, 

producing 1.41 mS cm-1).   

▪  The conductivity readings can now be obtained.  Initially, the conductivity readings for 

this experiment are recorded every 30 s for a period of 5 min, after which the readings 

are taken every 2 min for a period of 1 h.  Record the conductivity as λt. 

▪  After taking the readings, transfer the conductivity probe into an empty boiling tube.  

The boiling tube which contains the reaction mixture is then stoppered and placed in a 

beaker of water with a temperature of 60 °C for a period of 15 min in order to complete 

the hydrolysis. 

▪  When the hydrolysis is complete, cool the boiling tube by immersing it again in the 

water bath.  The final conductivity reading is taken when the reaction mixture in the 

boiling tube is at 30 °C. Record this conductivity as λ∞. 

▪  REPEAT THE ABOVE PROCEDURE using 0.2 mL and 0.4 mL of tert-butyl chloride in 

order to investigate the effect of concentration to the rate constant at constant 

temperature. 

▪  ASSIGN TWO OTHER GROUPS TO REPEAT THE ABOVE PROCEDURE using 0.2 

mL of tert-butyl chloride at 35°C and 40°C to calculate the activation energy, Ea. 

4 Calculations and Discussion 

The conductivity of the solution is proportionate with the amount of hydrogen chloride formed.  

(Alternatively, plot a calibration curve from the successive dilutions of the final reaction mixture 

with the solvation of 80% alcohol-water, and measure the conductivity for each dilution.) 

The rate constant for a first-order reaction can be written as: 

 

  𝑘 =
1

𝑡
ln

(𝜆∞−𝜆𝑜)

(𝜆∞−𝜆𝑡)
          (4) 

 

in which λo is the conductivity at t = 0, 

              λt is the conductivity at time t, and 

              λ∞ is the conductivity when the reaction is complete. 

 

The plot of ln
(𝜆∞−𝜆𝑜)

(𝜆∞−𝜆𝑡)
   against time, t, is a straight line with slope, k.  The half-life for this 

reaction is independent of the initial concentration of tert-butyl chloride, and the value of k is 

independent of the conductivity units used.  Hence, the cell constant for the conductivity probe 

is negligible.  In addition, the results are also not influenced by the existence of a trace foreign 

electrolyte since the calculation for k depends only on the difference between the two rates. 
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ATTENTION:  

If the value of k obtained for the different volume of tert-butyl chloride differs more than 5%, 

you are required to repeat the experiment. 

Show that the rate law is suitable with the mechanism suggested in the reaction. 

 

THE ARRHENIUS PLOT 

 

Relates the rate constant, k, to the activation energy, Ea 

● You will also need to perform the experiment in 35ºC and/or 40ºC in the following 

week/session 

 

The Arrhenius equation given as  

 

 𝑘 = 𝐴𝑒−
𝐸𝑎
𝑅𝑇, can be linearised as ln 𝑘 = ln 𝐴 −

𝐸𝑎

𝑅𝑇
 , 

 

where: 

 

k = reaction rate constant,  

A = pre-exponential factor,  

Ea = activation energy [J/mol],  

R = gas constant = 8.314 [J/(K.mol)], and 

T = absolute temperature [K]. 

 

Plotting ln(k) versus 1/T will give a straight line with a slope of -Ea/R, from which the activation 

energy Ea is calculated. 

 

5 References 

 

1. Hughes, E. A. Robertson R. E. Sugamori S. (1965). The Hydrolysis of t-Butyl Chloride 

in Water: Temperature-dependence of the Energy of Activation, Journal of the 

Chemical Society (Resumed). 

2. Euranto, Erkki & Kanerva, Liisa. (1983). Interpretation of the temperature dependence 

of the Arrhenius activation energy in solvolytic reactions. J. Chem. Soc., Faraday 

Trans. 1. 79. 10.1039/f19837901483.
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EXPERIMENT 4 

 

INFLUENCE OF CHAIN ELONGATION ON SURFACE ACTIVITY FOR NORMAL 

ALIPHATIC ALCOHOL 

 

Objectives:  

1. To determine the effects of chain length (n), concentration (C), and branching of 

alcohols on surface tension (γ). 

2. To find the surface excess concentration (Г), maximum surface excess concentration      

(Гmax) and minimum area occupied per alcohol molecule, Amin for n-amyl and t-butyl 

alcohols. 

 

1 Theory 

Surface activity is defined by the tendency of a particular chemical to adsorb on surface.  As 

a result, the concentration of the chemical on the surface is higher than that of in the solution 

(bulk concentration).  Chemicals that exhibit these properties are called surfactants. Typically, 

a surfactant molecule consists of one part that is a nonpolar chain, such as a hydrocarbon 

chain, and another part that is polar or ionized. A molecule with these two distinct properties 

can significantly influence the characteristics of its solution. The polarised chain will interact 

with aqueous phase, while the hydrocarbon chain, has no affinity with water.  Therefore, the 

surfactant molecule adsorbs at the surface in a manner that follows this orientation. Adsorption 

of surfactant molecules on the surface will cause a decrease in surface tension which the 

phenomena can be considered as a way to describe the surface activity.  

Quantitatively, the surface excess concentration (Γ) can be obtained from the surface tension 

(γ) and the internal concentration (C), through the Gibbs adsorption equation: 

Cd

d

RT ln

1 
=

 

Units 

  Γ in mol m-2;    γ in mol N m-1 

  R is 8.314 J K-1 mol-1;   T in K 

 

2 Materials 

Apparatus: Torsion balance, du Noüy ring, volumetric flasks, sample holder and 

thermometer. 

Chemicals: Alcohol solutions of methyl, ethyl, n-propyl, n-butyl, n-amyl and t-butyl alcohol. 

 

3 Experimental Procedure 

For the present procedure, all glasses must be washed carefully at first using chromic acid. 

The surface tension for distilled water must be determined as well.   
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SOLUTION A: Various chain length 

0.1 mol dm-3 alcohol solutions of methyl, ethyl, n-propyl, n-butyl and n-amyl can be prepared 

in 100 mL volumetric flask from the alcohol solutions of 0.40, 0.58, 0.75, 0.95 and 1.08 mL, 

respectively. Dilute the alcohol to the marked level with distilled water.   

 

The surface tension of each solution can be determined at room temperature using a torsion 

balance (Procedure for the operation of this equipment can be found from the laboratory 

assistant).  

 

SOLUTION B: Various concentrations of amyl alcohol 

Prepare solutions of amyl alcohol with concentrations of 

  

0.01, 0.02, 0.04, 0.06, 0.08, 0.10 mol dm-3 

 

whereas solutions of 0.15, 0.18 and 0.2 mol dm-3 have readily been prepared.  Shake the 

solutions to ensure all the alcohols have been diluted and determine the surface tension of 

each solution as described above. 

 

SOLUTION C: Various concentrations of t-butyl alcohol 

Repeat the procedures using t-butyl alcohol. Prepare a stock solution containing 6 g t-butyl 

alcohol in 100 mL solution in a 100 mL volumetric flask.  Dilute solutions of 

 

0.5, 1, 3, 5, 7, 10 and 13 mL 

 

to 100 mL with distilled water in volumetric flasks.  Determine the surface tensions for the 

solutions. 

 

4  Calculations and Discussion 

Plot a graph of surface tension (γ) versus the number of carbon atoms in alcohol.  Explain the 

result obtained.  The decreasing of surface tension can be assumed as a measurement of the 

alcohol surface activity. 

Plot  surface tension (γ) versus ln C as well for the amyl alcohol and draw a tangent on the 

line curve at 

C = 0.02, 0.04, 0.06, 0.08, 0.12 and 0.18 mol dm-3. 

Calculate surface excess concentration (Γ) for the various concentrations using the Gibbs 

adsorption equation.  Finally, plot surface excess concentration (Γ) versus concentration. 

i. Describe the shape of the graph.                 

ii. Determine the limiting value of surface excess concentration.               

iii. Use the limiting value in calculating the average surface area per amyl alcohol 

molecule.  Compare the area with the cross-sectional area of paraffin chain, namely 

0.195 cm2.  

iv. Discuss the significance of determining the limiting value of surface excess 

concentration (Γ) in the study of surfactants. 

v. Repeat the calculation for the t-butyl alcohol and comment on it.    
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